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ABOUT

Tarif is a typeface family inspired by the multicultural utopia of Convivencia - the peaceful coexistence of 
Muslims, Christians and Jews in tenth century Andalusia that  played an important role in bringing to 
Europe the classics of Greek philosophy, togheter with Muslim culture and aesthetics.

Designed for Zetafonts by Andrea Tartarelli, is a slab serif typeface with a humanist skeleton and 
inverted contrast, subtly mixing latin zest, calligraphic details, extreme inktraps, and postmodern 
unorthodox reinvention of traditional grotesque letter shapes. 
The exuberant design, perfect for titling, logo and display use, is complemented by a wide range of seven 
weights allowing for solid editorial use and great readability in body text. Matching italics have been 
designed with the help of Maria Chiara Fantini and Cosimo Lorenzo Pancini, while Rania Azmi has 
collaborated on the design of the arabic version of Tarif, where the humanist shapes and inverted 
contrast of the latin letters �nd a natural connection with modern arabic letterforms.

As buoyant as reliable, Tarif includes also a wide array of Open Type Features (alternates, ligatures, 
positional numerals, case sensitive punctuation) to make design smooth and multi-script projects as 
exciting as a surf ride in the sunny Tarifa.
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7 WEIGHTS WITH ITALICS
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TEXTPROOF

Antifašistická Akcia!!
The truth will set you free. But not until it is �nished with you.

Cantina Castelões™
The richest man is not he who has the most, but he who

Değiştirilemez Teklif
The sun machine is coming down, and we're gonna have a

Linee sospese per neve
Always forgive your enemies; nothing annoys them so much

Ert Þú Bókstafstrúar
All that we see or seem is but a dream within a dream.

Condizioni, pagamenti
The cure for boredom is curiosity. There is no cure

David Foster Wallace
Ground Control to Major Tom. Can you hear me, Major

Irwin Allen Ginsberg
You miss 100% of the shots you never take. Do you?

“LÄBIVIIMISESSE”
the man who only has a hammer, everything he encounters

RAPPREŻENTANZA
Over thinking, over analyzing, separates the body from the...

PAȘALÂCUL BUDA!!
Wear the grudge like a crown of negativity calculate what

DI ENERGIA E FORZA
We are what we repeatedly do; excellence, then, is not a choiche

FRANĠISKU JĊEMPEL
We can be heroes, forever and ever. What d'you say? [...]

AZGARAD FETIŠISM
I worry about being a success in a mediocre world⁽²⁾

150 COPII FRUMOȘI
We are choosing to be here right now hold on, stay inside

¿ES INESCRUTABLE?
I’d rather live with a good question than a bad answer.
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1 THE MAN WITHOUT QUALITIES (1930) - “A 
barometric low hung over the Atlantic. It moved 
eastward toward a high-pressure area over Russia without 
as yet showing any [...]„ Robert Musil

Extralight pt 10 Medium pt 10

Bold pt 10

Extrabold pt 10

Regular pt 10

Light pt 10

Book pt 10

2 GRAVITY'S RAINBOW (1973) - “It has happened 
before,but there is nothing to compare it to now.It is too 
late. The Evacuation still proceeds, but it's all theatre.„ 
Thomas Pynchon

3 ULYSSES (1922) - “Stately, plump buck mulligan came 
from the stairhead, bearing a bowl of lather on which a 
mirror and a razor lay crossed. A yellow dressing gown, 
ungirdled„ James Joyce

5 IF ON A WINTER'S NIGHT A TRAVELER (1979) - 
“You are about to begin reading Italo Calvino's new 
novel, If on a winter's night a traveler.„ I
talo Calvino

6 THE CATCHER IN THE RYE (1951) - “If you really 
want to hear about it, the �rst thing you'll proba-
bly want to know is where I was born [...] 
J.D.Salinger

7 THE MAKING OF AMERICANS (1925) - “Once an 
angry man dragged his father along the ground 
through his own orchard.„ 
Gertrude Stein
 

4 MATTATOIO N.5 (1969) - “È tutto accaduto, più o 
meno. Le parti sulla guerra, in ogni caso, sono abbas-
tanza vere. Un tale che conoscevo fu veramente ucciso, 
[...]„ Kurt Vonnegut
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The so-called ‘psychotically depressed’ person who tries to 

kill herself doesn’t do so out of quote ‘hopelessness’ or any 

abstract conviction that life’s assets and debits do not 

square. And surely not because death seems suddenly 

appealing. The person in whom Its invisible agony 

reaches a certain unendurable level will kill herself 

the same way a trapped person will eventually 

TEXT PROOF

The so-called ‘psychotically 
depressed’ person who tries to kill 
herself doesn’t do so out of quote 

‘hopelessness’ or any abstract 
conviction that life’s assets and 

debits do not square. And surely 
not because death seems 

suddenly appealing. The person 
in whom Its invisible agony 

reaches a certain unendurable 
level will kill herself the same 

way a trapped person will 
eventually jump from the 

window of a burning high-rise. 
Make no mistake about people 

who leap from burning windows. 
Their terror of falling from a 

great height is still just as great 
as it would be for you or me 

standing speculatively at the 
same window just checking out 
the view; i.e. the fear of falling 

remains a constant. The variable 
here is the other terror, the �re’s 

�ames.

Light&Medium Italic 9 pt

Light 20 pt

Extralight 20 pt

Book 20 pt

Regular 20 pt

Medium 20 pt

Bold 20 pt

Extrabold 20 pt



16pt / 20 - Mixed Weights 

12pt / 16 - Mixed Weights

10pt / 14 - Mixed Weights 8pt / 12 - Mixed Weights

20pt / 24 - Mixed Weights 

Nero (Latin: Nero Claudius Caesar Augustus Germanicus) was the last 
Roman emperor of the Julio-Claudian dynasty. He was born Lucius Domi-
tius Ahenobarbus on 15 December 37 ad in Antium. Nero was adopted by 
his great-uncle Claudius and became his heir and successor. Nero’s mother, 
Agrippina the Younger, was likely implicated in Claudius’s death and 
Nero’s nomination as emperor. 

During the early years of his reign, Nero was content to be guided by his mother, his tutor 
Lucius Annaeus Seneca and his Praetorian prefect, Sextus Afranius Burrus. As time passed, 
he started to play a more active and independent role in government and foreign policy. 
During his reign, the redoubtable general Corbulo conducted a successful war and negotiated 
peace with the Parthian Empire. 
His general Suetonius Paulinus crushed a major revolt in Britain, led by the Iceni Queen 
Boudica. Nero focused much of his attention on diplomacy, trade and the cultural life of 
the empire, ordering theatres built and promoting athletic games.

Nero’s rule is usually associated with tyranny and extravagance. Most Roman sources, such as Suetonius and Cassius Dio, 
o�er overwhelmingly negative assessments of his personality and reign. Tacitus claims that “the Roman people thought him 
compulsive and corrupt”. Suetonius tells that “many Romans believed that the Great Fire of Rome was instigated by Nero to 
clear the way for his planned palatial complex, the Domus Aurea.”
According to Tacitus he was said to have seized Christians as scapegoats for the �re and burned them alive, seemingly 
motivated not by public justice but by personal cruelty. Some modern historians question the reliability of the ancient 
sources on Nero’s tyrannical acts. A few sources paint Nero in a more favorable light. There is evidence of his popularity 
among the Roman commoners, especially in the eastern provinces of the Empire, where a popular legend arose that Nero had 
not died and would return. 

Nero’s father, Domitius, died in 40. A few years before his death, 
Domitius had been involved in a political scandal that, according to 
Malitz: “could have cost him his life if Tiberius had not died in the 
year 37, since in the previous year, Nero’s mother Agrippina had been 
caught up in a scandal of her own”. Caligula’s beloved sister Drusilla 
had recently died and Caligula began to feel threatened by his 
brother-in-law Marcus Aemilius Lepidus. Agrippina, suspected of 
adultery with her brother-in-law, was forced to carry the funerary urn 
after Lepidus’ execution. Caligula then banished his two surviving 
sisters, Agrippina and Julia Livilla, to a remote island in the 
Mediterranean Sea.
According to The Oxford Encyclopedia of Ancient Greece and Rome, 
Agrippina was exiled for plotting to overthrow Caligula.

Caligula’s reign lasted from 37 until 41. He died from multiple stab wounds in January 
of 41 after being ambushed by his own Praetorian Guard on the Palatine Hill. Claudius 
succeeded Caligula as Emperor. Agrippina married Claudius in 49 ad and became his 
fourth wife. By February 49, she had persuaded Claudius to adopt her son Nero. After 
Nero’s adoption, “Claudius” became part of his name: Nero Claudius Caesar Drusus 
Germanicus. Claudius had gold coins issued to mark the adoption. Classics professor 
Josiah Osgood has written that “the coins, through their distribution and imagery alike, 
showed that a new Leader was in the making.” David Shotter noted that, despite events 
in Rome, Nero’s step-brother Britannicus was more prominent in provincial coinages 
during the early 50s.
The ancient biographer Suetonius, who was critical of Nero’s ancestors, wrote that 
Augustus had reproached Nero’s grandfather for his unseemly enjoyment of violent 
gladiator games. According to Jürgen Malitz, Suetonius tells that Nero’s father was 
known to be “irascible and brutal”, and that both “enjoyed chariot races and theater 
performances to a degree not be�tting their position.”
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STYLISTIC ALTERNATES

Stylistic Alternates or Stylistic Sets were designed to o�er a secondary form of a character.

↓ ↓ ↓
Discidia
Discidia

STYLISTIC SET 01, 02, 03...

There are more than one Stylistic Set. Check out the possibilities of text appearance.

Wayment

Wayment
↓ ↓
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STANDARD                LIGATURES

� � � � � 

ffi→�
�

LIGATURE LIST

The standard ligatures are designed to correct awkward text combinations 
of letters, such as �, �, �. Such ligatures are applied by default

DISCRETIONARY               LIGATURES         �

� � � � � � �  

Discretionary Ligatures are ligatures applied at the user's discretion.

fb→�
LIGATURE LIST
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SPECIAL LIGATURES

(1)(2) 
circular number

12 

black circular number

((1))((2))
↓ ↓

12 

<+-/|+> 
arrows

↓
 ←↘↓↙→

 ↖↑↗

The Special Ligatures o�er you the possibility to get special symbols by using key combinations without 
glyph panel. These are activated enabling Discretionary Ligatures.

[No.]
number

№

copyright

(C)

© ®

registered

(R) [TM]
trademark

™
↓ ↓ ↓ ↓

LETTER COMBINATIONS

There are also Special letter combinations  this solution o�er you the possibility to get special symbols by using 
key combinations without glyph panel. These are activated enabling Discretionary Ligatures.
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ALTERNATE FIGURES

Tabular Figures are especially useful while setting columns of numbers, such as in �nancial reports. 

123
proportional old style

123
proportional lining

|1|2|3|
tabular lining

|1|2|3|
tabular old style

↓
↓

POSITIONING FIGURES/FRACTIONS

12⁄23
fraction

1ˢ
ordinals superscript

superior

X¹²
subscript-inferior

H₂O

numerator

N123
denominator

D234
These various kind of �gures are used for fractions, footnote references, chemical compounds, and as mathematical 

exponents.

TARIF

ZETAFONTS.COM Zetafonts.com/Tarif



SMALLCAPS

Tropicalia
Tropicalia

→

Small Caps feature substitutes lowercase with a capital versions of the letters sets within the x-height 

Лорем ипсум долор, дуо ут импетус диспутандо,фура салфеточка филонить  

CYRILLIC SCRIPT

TARIF
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OTHER SCRIPT

АБВГҐДЕЗЖИЛМНОПРСТУФХЧЦШЩЬЪЫЉЊЅІЈЋЮЯЂЛ - ЃЁЙЇ
абвгґдежзклмнопрстуфхчцшщџьъыљњѕэіјћюя - ѓёйїђ 

CYRILLIC UPPERCASE & lowercase

abcdefghijklmnopqrstuvwxyz
áăâäàāąåãǽćčçĉċďđéĕěêëėẹèēęẽğǧĝģġħĥíĭîïịìĳīįĩĵķĸ

ĺľļŀłńňņñóŏôöọòőōǫøǿõŕřŗśšşŝșŧťțúŭûüụùűūųůũẃŵẅẁýŷÿỳȳỹźžż

CYRILLIC SMALLCAPS
абвгґдежзклмнопрстуфхчцшщџьъыљњѕэіјћюя

 

SMALLCAPS

CHARACTER SET

ABCDEFGHIJKLMNOPQRSTUVWXYZ - ÆŒÞÐ
ÁĂÂÄÀĀĄÅÃǼĆČÇĈĊĎĐÉĔĚÊËĖÈĒĘĞĜĢĠĦĤĲÍĬÎÏİÌĪĮĨĴĶĹĽĻĿŃŇŅŊÑÓŎÔÖÒ

ŐŌØÕŔŘŖŚŠŞŜȘŦŤŢȚÚŬÛÜÙŰŪŲŮŨẂŴẄẀÝŶŸỲŹŽŽ - 
alternates W  

abcdefghijklmnopqrstuvwxyz - æœþðß
ááâàāąåãćçĉċďđéĕěêëėēęğĝġħĥíĭîïìĳīįĩķĸĺļŀńňņŋñ

óŏôöòőōøõŕřŗśšşŝșŧťţțúŭûüùűūųůŵẅẁýŷÿỳźžż  alternates acrs 

0123456789
0123456789 0123456789 0123456789 

⁰¹²³⁴⁵⁶⁷⁸⁹01234567890123456789₀₁₂₃₄₅₆₇₈₉

UPPERCASE & ACCENTED

lowercase & accented

Figures & Mathematical notations 

Standard & Discretionary ligatures

. , : ;…!¡?¿·•*�# ․/\(){}[]-–—_„“” ‘ ’«»‹›”’¢¤$€ƒ£¥¢++−×÷=≠><≥≤±≈~¬^∞∫Ω∆∏∑µ∂%‰
↑↗→↘↓↙←↖◊@&¶§©®™°|¦†01234567890123456789

Punctuation & Symbols

� � � � � ffj � � � � fj � � � �
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NUMBERS

Afrikaans, Albanian, Asu, Azerbaijani, Basque, Bemba, Bena, Bosnian, Breton, Bulgarian, Catalan, 
Chiga, Colognian, Cornish, Croatian, Czech, Danish, Dutch, English, Esperanto, Estonian, Faroese, 
Filipino, Finnish, French, Friulian, Galician, Ganda, German, Greek, Gusii, Hungarian, Icelandic, Inari 
Sami, Indonesian, Irish, Italian, Jola-Fonyi, Kabuverdianu, Kalenjin, Kinyarwanda, Low German, Lower 
Sorbian, Luo, Luxembourgish, Luyia, Macedonian, Machame, Makhuwa-Meetto, Makonde, Malagasy, 
Malay, Maltese, Manx, Morisyen, North Ndebele, Northern Sami, Norwegian Bokmål, Norwegian 
Nynorsk, Nyankole, Oromo, Portuguese, Quechua, Romansh, Rombo, Rundi, Russian, Rwa, Samburu, 
Sango, Sangu, Scottish Gaelic, Sena, Serbian, Shambala, Shona, Slovak, Slovenian, Soga, Somali, Span-
ish, Swahili, Swedish, Swiss German, Taita, Teso, Turkish, Turkmen, Ukrainian, Upper Sorbian, Vunjo, 
Walser, Welsh, Western Frisian, Wolof, Zulu

1200+ chars
220+ languages

3 scripts: latin, arabic, cyrillic
COMMON LANGUAGES
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Altitude 8.849 m
above the level of the sea
It is Earth's highest mountain above sea level, 
located in the Mahalangur Himal sub-range of 
the Himalayas. The international border 
between Nepal (Province No. 1) and China 
(Tibet Autonomous Region) runs across its 
summit point.

EVEREST

Altitude 6.962 m
above the level of the sea
It is located in the Principal Cordillera[4] of the 
Andes mountain range, in the Mendoza 
Province, Argentina, and lies 112 km (70 mi) 
northwest of its capital, the city of Mendoza, 
about �ve km (3.1 mi) from San Juan Province 
and 15 km (9.3 mi) from the international 
border with Chile.

ACONCAGUA

Altitude 4.810 m
above the level of the sea
It is the highest mountain in the Alps and the 
highest in Europe west of the Caucasus peaks of 
Russia and Georgia. It rises 4,808 m (15,774 ft) 
above sea level and is ranked 11th in the world 
in topographic prominence. The mountain 
stands in a range called the Graian Alps, 
between the regions of Aosta Valley, Italy, and 
Savoie and Haute-Savoie, France. 

MONT BLANC

Mountain
ABCDEFGHIJKLMN
OPQRSTUVWWXYZ
aabccdefghijklmn
opqrrsstuvwxyz
012233455667899



HOW TO USE FEATURES

All Zetafonts typefaces feature extra glyphs 
and functions that are available with Open 
Type technology (works on Adobe software, 
Word, and newer Os). Open Type features are 

activated in Illustrator, InDesign and Photo-
shop through multiple option checks in the 
Type → Open Type panel.

The OpenType format makes it possible to 
incorporate typographic features, such as 
small caps, ligatures, old style numerals 
and lining numerals, all within one font 
�le, thereby simplifying font 
management and usage.

To activate Open Type panel select
in the menu:
Window → Type → Opentype panel

for more information check our faq page:

http://bit.ly/zetafaq
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In the package are available the most common �le format for every purpose:
TTF, OTF, EOT, WOFF, WOFF2

→ Install on Windows 10

Once downloaded, right-click on the �le, select “Extract All”. After extraction (or accessing the �le at its down-
loaded destination), right-click on the �le and select “Install”. Otherwise navigate to Cortana’s search �eld on 
the taskbar, type “Control Panel” and click the corresponding result. With the Control Panel open, navigate to 
“Appearance and Personalization” and click on “Fonts” in the main window.
Here you can Drag and Drop your �les.

→ Install on Mac OS

Double click the unzipped font �le and Font Book will open a preview of the font.
Click “Install Font” at the bottom of the preview.

AVAILABLE FORMATS AND INSTALLATION SPEC
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HOW TO GET THE FONT    
In order to use our fonts in a commercial project, you need to pay a license fee that varies according to 
usage and number of users. Acquiring a license on our website www.zetafonts.com is the fastest way. 
You will be able to download the fonts immediately after the payment. Our website accepts payments 
with credit card or with PayPal account, both using PayPal POS that accepts all main credit cards. 
For more information about licensing, visit www.zetafonts.com/licensing 

TRY BEFORE YOU BUY
Our fonts are free to try and for personal/non-commercial use. You can download the trial version in 
order to test the integration in your design by visiting the font page on www.zetafonts.com

CUSTOM FONT
Custom fonts is part of the services we o�er as a type foundry. This include design completely new 
typefaces, modi�cations of existing ones, or creation of special language sets. For more information 
visit: www.zetafonts.com/custom-fonts 

WEBFONTS
All Zetafonts typefaces are available also as webfonts as self-hosting webfont licence. We provide the 
fonts as EOT, WOFF, WOFF2 formats.



Zetafonts is an independent digital type foundry run by an Italian 
type designer Team and currently based in Florence. It has spent 
more than a decade designing typefaces for print, digital, 
environmental design, branding and corporation. Besides creating a 
wide range of high quality retail typefaces, Zetafonts also provides 
custom typeface design services for commercial and institutional 
clients.

© 2019 Ligature srl. 
All rights reserved.

Zetafonts is a Ligature srl division

Ligature srl
via ghibellina 100
50122 Florence
Italy

info@zetafonts.com
www.zetafonts.com



ZETAFONTS
FOUNDRY

ZETAFONTS.COM

CONTACT: INFO@ZETAFONTS.COM 



Iconic
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ABOUT

Tarif is a typeface family inspired by the multicultural utopia of Convivencia - the peaceful coexistence of 
Muslims, Christians and Jews in tenth century Andalusia that  played an important role in bringing to 
Europe the classics of Greek philosophy, togheter with Muslim culture and aesthetics.

Designed for Zetafonts by Andrea Tartarelli, is a slab serif typeface with a humanist skeleton and 
inverted contrast, subtly mixing latin zest, calligraphic details, extreme inktraps, and postmodern 
unorthodox reinvention of traditional grotesque letter shapes. 
The exuberant design, perfect for titling, logo and display use, is complemented by a wide range of seven 
weights allowing for solid editorial use and great readability in body text. Matching italics have been 
designed with the help of Maria Chiara Fantini and Cosimo Lorenzo Pancini, while Rania Azmi has 
collaborated on the design of the arabic version of Tarif, where the humanist shapes and inverted 
contrast of the latin letters �nd a natural connection with modern arabic letterforms.
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HOW TO USE FEATURES

All Zetafonts typefaces feature extra glyphs 
and functions that are available with Open 
Type technology (works on Adobe software, 
Word, and newer Os). Open Type features are 

activated in Illustrator, InDesign and Photo-
shop through multiple option checks in the 
Type → Open Type panel.

The OpenType format makes it possible to 
incorporate typographic features, such as 
small caps, ligatures, old style numerals 
and lining numerals, all within one font 
�le, thereby simplifying font 
management and usage.

To activate Open Type panel select
in the menu:
Window → Type → Opentype panel

for more information check our faq page:

http://bit.ly/zetafaq
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Extralight
Light
Regular
Medium
Semibold
Bold

Black

Extralight Italic
Light Italic
Italic
Medium Italic
Semibold Italic
Bold Italic

Black Italic

Extralight
Light
Book
Regular
Medium
Bold

Black

Extralight Italic
Light Italic
Book Italic
Italic
Medium Italic
Bold Italic

Black Italic
Extrabold Extrabold Italic Extrabold Extrabold Italic
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NUMBERS

Afrikaans, Albanian, Asu, Azerbaijani, Basque, Bemba, Bena, Bosnian, Breton, Bulgarian, Catalan, 
Chiga, Colognian, Cornish, Croatian, Czech, Danish, Dutch, English, Esperanto, Estonian, Faroese, 
Filipino, Finnish, French, Friulian, Galician, Ganda, German, Greek, Gusii, Hungarian, Icelandic, Inari 
Sami, Indonesian, Irish, Italian, Jola-Fonyi, Kabuverdianu, Kalenjin, Kinyarwanda, Low German, Lower 
Sorbian, Luo, Luxembourgish, Luyia, Macedonian, Machame, Makhuwa-Meetto, Makonde, Malagasy, 
Malay, Maltese, Manx, Morisyen, North Ndebele, Northern Sami, Norwegian Bokmål, Norwegian 
Nynorsk, Nyankole, Oromo, Portuguese, Quechua, Romansh, Rombo, Rundi, Russian, Rwa, Samburu, 
Sango, Sangu, Scottish Gaelic, Sena, Serbian, Shambala, Shona, Slovak, Slovenian, Soga, Somali, Span-
ish, Swahili, Swedish, Swiss German, Taita, Teso, Turkish, Turkmen, Ukrainian, Upper Sorbian, Vunjo, 
Walser, Welsh, Western Frisian, Wolof, Zulu

1200+ chars
220+ languages

3 scripts: latin, arabic, cyrillic
COMMON LANGUAGES
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STYLISTIC ALTERNATES

Stylistic Alternates or Stylistic Sets were designed to o�er a secondary form of a character.

↓ ↓ ↓
Discidia
Discidia
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STYLISTIC SET 01, 02, 03...

There are more than one Stylistic Set. Check out the possibilities of text appearance.

Wayment

Wayment
↓ ↓



STANDARD                LIGATURES

� � � � � 

ffi→�
�

LIGATURE LIST

The standard ligatures are designed to correct awkward text combinations 
of letters, such as �, �, �. Such ligatures are applied by default
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DISCRETIONARY               LIGATURES         �

� � � � � � �  

Discretionary Ligatures are ligatures applied at the user's discretion.

fb→�
LIGATURE LIST
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SMALLCAPS

Tropicalia
Tropicalia
→

Small Caps feature substitutes lowercase with a capital versions of the letters sets within the x-height 
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Лорем ипсум долор, дуо ут импетус диспутандо,фура салфеточка филонить  

CYRILLIC SCRIPT



ALTERNATE FIGURES

Tabular Figures are especially useful while setting columns of numbers, such as in �nancial reports. 

123
proportional old style

123
proportional lining

|1|2|3|
tabular lining

|1|2|3|
tabular old style

↓
↓
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POSITIONING FIGURES/FRACTIONS

12⁄23
fraction

1ˢ
ordinals superscript

superior

X¹²
subscript-inferior

H₂O

numerator

N123
denominator

D234
These various kind of �gures are used for fractions, footnote references, chemical compounds, and as mathematical 

exponents.
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SPECIAL LIGATURES

(1)(2) 
circular number

12 

black circular number

((1))((2))
↓ ↓

12 

<+-/|+> 
arrows

↓
 ←↘↓↙→

 ↖↑↗

The Special Ligatures o�er you the possibility to get special symbols by using key combinations without 
glyph panel. These are activated enabling Discretionary Ligatures.
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[No.]
number

№

copyright

(C)

© ®

registered

(R) [TM]
trademark

™
↓ ↓ ↓ ↓

LETTER COMBINATIONS

There are also Special letter combinations  this solution o�er you the possibility to get special symbols by using 
key combinations without glyph panel. These are activated enabling Discretionary Ligatures.
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The so-called ‘psychotically depressed’ person who tries to 

kill herself doesn’t do so out of quote ‘hopelessness’ or any 

abstract conviction that life’s assets and debits do not 

square. And surely not because death seems suddenly 

appealing. The person in whom Its invisible agony 

reaches a certain unendurable level will kill herself 

the same way a trapped person will eventually 

TEXT PROOF

The so-called ‘psychotically 
depressed’ person who tries to kill 
herself doesn’t do so out of quote 

‘hopelessness’ or any abstract 
conviction that life’s assets and 

debits do not square. And surely 
not because death seems 

suddenly appealing. The person 
in whom Its invisible agony 

reaches a certain unendurable 
level will kill herself the same 

way a trapped person will 
eventually jump from the 

window of a burning high-rise. 
Make no mistake about people 

who leap from burning windows. 
Their terror of falling from a 

great height is still just as great 
as it would be for you or me 

standing speculatively at the 
same window just checking out 
the view; i.e. the fear of falling 

remains a constant. The variable 
here is the other terror, the �re’s 

�ames.

Light&Medium Italic 9 pt

Light 20 pt

Extralight 20 pt

Book 20 pt

Regular 20 pt

Medium 20 pt

Bold 20 pt

Extrabold 20 pt
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1 THE MAN WITHOUT QUALITIES (1930) - “A 
barometric low hung over the Atlantic. It moved 
eastward toward a high-pressure area over Russia without 
as yet showing any [...]„ Robert Musil

Extralight pt 10 Medium pt 10

Bold pt 10

Extrabold pt 10

Regular pt 10

Light pt 10

Book pt 10

2 GRAVITY'S RAINBOW (1973) - “It has happened 
before,but there is nothing to compare it to now.It is too 
late. The Evacuation still proceeds, but it's all theatre.„ 
Thomas Pynchon

3 ULYSSES (1922) - “Stately, plump buck mulligan came 
from the stairhead, bearing a bowl of lather on which a 
mirror and a razor lay crossed. A yellow dressing gown, 
ungirdled„ James Joyce

5 IF ON A WINTER'S NIGHT A TRAVELER (1979) - 
“You are about to begin reading Italo Calvino's new 
novel, If on a winter's night a traveler.„ I
talo Calvino

6 THE CATCHER IN THE RYE (1951) - “If you really 
want to hear about it, the �rst thing you'll proba-
bly want to know is where I was born [...] 
J.D.Salinger

7 THE MAKING OF AMERICANS (1925) - “Once an 
angry man dragged his father along the ground 
through his own orchard.„ 
Gertrude Stein
 

4 MATTATOIO N.5 (1969) - “È tutto accaduto, più o 
meno. Le parti sulla guerra, in ogni caso, sono abbas-
tanza vere. Un tale che conoscevo fu veramente ucciso, 
[...]„ Kurt Vonnegut
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CHARACTER SET

ABCDEFGHIJKLMNOPQRSTUVWXYZ - ÆŒÞÐ
ÁĂÂÄÀĀĄÅÃǼĆČÇĈĊĎĐÉĔĚÊËĖÈĒĘĞĜĢĠĦĤĲÍĬÎÏİÌĪĮĨĴĶĹĽĻĿŃŇŅŊÑÓŎÔÖÒ

ŐŌØÕŔŘŖŚŠŞŜȘŦŤŢȚÚŬÛÜÙŰŪŲŮŨẂŴẄẀÝŶŸỲŹŽŽ - 
alternates W  

abcdefghijklmnopqrstuvwxyz - æœþðß
ááâàāąåãćçĉċďđéĕěêëėēęğĝġħĥíĭîïìĳīįĩķĸĺļŀńňņŋñ

óŏôöòőōøõŕřŗśšşŝșŧťţțúŭûüùűūųůŵẅẁýŷÿỳźžż  alternates acrs 

0123456789
0123456789 0123456789 0123456789 

⁰¹²³⁴⁵⁶⁷⁸⁹01234567890123456789₀₁₂₃₄₅₆₇₈₉

UPPERCASE & ACCENTED

lowercase & accented

Figures & Mathematical notations 

Standard & Discretionary ligatures

. , : ;…!¡?¿·•*�# ․/\(){}[]-–—_„“” ‘ ’«»‹›”’¢¤$€ƒ£¥¢++−×÷=≠><≥≤±≈~¬^∞∫Ω∆∏∑µ∂%‰
↑↗→↘↓↙←↖◊@&¶§©®™°|¦†01234567890123456789

Punctuation & Symbols

� � � � � ffj � � � � fj � � � �
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OTHER SCRIPT

АБВГҐДЕЗЖИЛМНОПРСТУФХЧЦШЩЬЪЫЉЊЅІЈЋЮЯЂЛ - ЃЁЙЇ
абвгґдежзклмнопрстуфхчцшщџьъыљњѕэіјћюя - ѓёйїђ 

CYRILLIC UPPERCASE & lowercase

abcdefghijklmnopqrstuvwxyz
áăâäàāąåãǽćčçĉċďđéĕěêëėẹèēęẽğǧĝģġħĥíĭîïịìĳīįĩĵķĸ

ĺľļŀłńňņñóŏôöọòőōǫøǿõŕřŗśšşŝșŧťțúŭûüụùűūųůũẃŵẅẁýŷÿỳȳỹźžż

CYRILLIC SMALLCAPS
абвгґдежзклмнопрстуфхчцшщџьъыљњѕэіјћюя

 

SMALLCAPS
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TEXTPROOF

Antifašistická Akcia!!
The truth will set you free. But not until it is �nished with you.

Cantina Castelões™
The richest man is not he who has the most, but he who

Değiştirilemez Teklif
The sun machine is coming down, and we're gonna have a

Linee sospese per neve
Always forgive your enemies; nothing annoys them so much

Ert Þú Bókstafstrúar
All that we see or seem is but a dream within a dream.

Condizioni, pagamenti
The cure for boredom is curiosity. There is no cure

David Foster Wallace
Ground Control to Major Tom. Can you hear me, Major

Irwin Allen Ginsberg
You miss 100% of the shots you never take. Do you?

“LÄBIVIIMISESSE”
the man who only has a hammer, everything he encounters

RAPPREŻENTANZA
Over thinking, over analyzing, separates the body from the...

PAȘALÂCUL BUDA!!
Wear the grudge like a crown of negativity calculate what

DI ENERGIA E FORZA
We are what we repeatedly do; excellence, then, is not a choiche

FRANĠISKU JĊEMPEL
We can be heroes, forever and ever. What d'you say? [...]

AZGARAD FETIŠISM
I worry about being a success in a mediocre world⁽²⁾

150 COPII FRUMOȘI
We are choosing to be here right now hold on, stay inside

¿ES INESCRUTABLE?
I’d rather live with a good question than a bad answer.
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Iconic
A multi-weight rounded family w



ABOUT

Tarif is a typeface family inspired by the multicultural utopia of Convivencia - the peaceful coexistence of 
Muslims, Christians and Jews in tenth century Andalusia that  played an important role in bringing to 
Europe the classics of Greek philosophy, togheter with Muslim culture and aesthetics.

Designed for Zetafonts by Andrea Tartarelli, is a slab serif typeface with a humanist skeleton and 
inverted contrast, subtly mixing latin zest, calligraphic details, extreme inktraps, and postmodern 
unorthodox reinvention of traditional grotesque letter shapes. 
The exuberant design, perfect for titling, logo and display use, is complemented by a wide range of seven 
weights allowing for solid editorial use and great readability in body text. Matching italics have been 
designed with the help of Maria Chiara Fantini and Cosimo Lorenzo Pancini, while Rania Azmi has 
collaborated on the design of the arabic version of Tarif, where the humanist shapes and inverted 
contrast of the latin letters �nd a natural connection with modern arabic letterforms.

As buoyant as reliable, Tarif includes also a wide array of Open Type Features (alternates, ligatures, 
positional numerals, case sensitive punctuation) to make design smooth and multi-script projects as 
exciting as a surf ride in the sunny Tarifa.



HOW TO USE FEATURES

All Zetafonts typefaces feature extra glyphs 
and functions that are available with Open 
Type technology (works on Adobe software, 
Word, and newer Os). Open Type features are 

activated in Illustrator, InDesign and Photo-
shop through multiple option checks in the 
Type → Open Type panel.

The OpenType format makes it possible to 
incorporate typographic features, such as 
small caps, ligatures, old style numerals 
and lining numerals, all within one font 
�le, thereby simplifying font 
management and usage.

To activate Open Type panel select
in the menu:
Window → Type → Opentype panel

for more information check our faq page:

http://bit.ly/zetafaq



Extralight
Light
Regular
Medium
Semibold
Bold

Black

Extralight Italic
Light Italic
Italic
Medium Italic
Semibold Italic
Bold Italic

Black Italic

Extralight
Light
Book
Regular
Medium
Bold

Black

Extralight Italic
Light Italic
Book Italic
Italic
Medium Italic
Bold Italic

Black Italic
Extrabold Extrabold Italic Extrabold Extrabold Italic

DISPLAY
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NUMBERS

Afrikaans, Albanian, Asu, Azerbaijani, Basque, Bemba, Bena, Bosnian, Breton, Bulgarian, Catalan, 
Chiga, Colognian, Cornish, Croatian, Czech, Danish, Dutch, English, Esperanto, Estonian, Faroese, Filipi-
no, Finnish, French, Friulian, Galician, Ganda, German, Greek, Gusii, Hungarian, Icelandic, Inari Sami, 
Indonesian, Irish, Italian, Jola-Fonyi, Kabuverdianu, Kalenjin, Kinyarwanda, Low German, Lower Sor-
bian, Luo, Luxembourgish, Luyia, Macedonian, Machame, Makhuwa-Meetto, Makonde, Malagasy, 
Malay, Maltese, Manx, Morisyen, North Ndebele, Northern Sami, Norwegian Bokmål, Norwegian 
Nynorsk, Nyankole, Oromo, Portuguese, Quechua, Romansh, Rombo, Rundi, Russian, Rwa, Samburu, 
Sango, Sangu, Scottish Gaelic, Sena, Serbian, Shambala, Shona, Slovak, Slovenian, Soga, Somali, Span-
ish, Swahili, Swedish, Swiss German, Taita, Teso, Turkish, Turkmen, Ukrainian, Upper Sorbian, Vunjo, 
Walser, Welsh, Western Frisian, Wolof, Zulu

1200+ chars
220+ languages

3 scripts: latin, arabic, cyrillic
COMMON LANGUAGES



STYLISTIC ALTERNATES

Stylistic Alternates or Stylistic Sets were designed to o�er a secondary form of a character.

↓ ↓ ↓
Discidia
Discidia



STYLISTIC SET 01, 02, 03...

There are more than one Stylistic Set. Check out the possibilities of text appearance.

Wayment

Wayment
↓ ↓



STANDARD                LIGATURES

� � � � � 

ffi→�
�

LIGATURE LIST

The standard ligatures are designed to correct awkward text combinations 
of letters, such as �, �, �. Such ligatures are applied by default



DISCRETIONARY               LIGATURES         �

� � � � � � �  

Discretionary Ligatures are ligatures applied at the user's discretion.

fb→�
LIGATURE LIST



SMALLCAPS

Tropicalia
Tropicalia
→

Small Caps feature substitutes lowercase with a capital versions of the letters sets within the x-height 



Лорем ипсум долор, дуо ут импетус диспутандо,фура салфеточка филонить  

CYRILLIC SCRIPT



ALTERNATE FIGURES

Tabular Figures are especially useful while setting columns of numbers, such as in �nancial reports. 

123
proportional old style

123
proportional lining

|1|2|3|
tabular lining

|1|2|3|
tabular old style

↓
↓



POSITIONING FIGURES/FRACTIONS

12⁄23
fraction

1ˢ
ordinals superscript

superior

X¹²
subscript-inferior

H₂O

numerator

N123
denominator

D234
These various kind of �gures are used for fractions, footnote references, chemical compounds, and as mathematical 

exponents.



SPECIAL LIGATURES

(1)(2) 
circular number

12 

black circular number

((1))((2))
↓ ↓

12 

<+-/|+> 
arrows

↓
 ←↘↓↙→

 ↖↑↗

The Special Ligatures o�er you the possibility to get special symbols by using key combinations without 
glyph panel. These are activated enabling Discretionary Ligatures.



[No.]
number

№

copyright

(C)

© ®

registered

(R) [TM]
trademark

™
↓ ↓ ↓ ↓

LETTER COMBINATIONS

There are also Special letter combinations  this solution o�er you the possibility to get special symbols by using 
key combinations without glyph panel. These are activated enabling Discretionary Ligatures.



The so-called ‘psychotically depressed’ person who tries to 

kill herself doesn’t do so out of quote ‘hopelessness’ or any 

abstract conviction that life’s assets and debits do not 

square. And surely not because death seems suddenly ap-

pealing. The person in whom Its invisible agony reaches 

a certain unendurable level will kill herself the same 

way a trapped person will eventually jump from 

TEXT PROOF

The so-called ‘psychotically 
depressed’ person who tries to kill 
herself doesn’t do so out of quote 

‘hopelessness’ or any abstract 
conviction that life’s assets and 

debits do not square. And surely 
not because death seems sudden-

ly appealing. The person in whom 
Its invisible agony reaches a 

certain unendurable level will 
kill herself the same way a 

trapped person will eventually 
jump from the window of a 
burning high-rise. Make no 

mistake about people who leap 
from burning windows. Their 
terror of falling from a great 

height is still just as great as it 
would be for you or me standing 

speculatively at the same window 
just checking out the view; i.e. 

the fear of falling remains a 
constant. The variable here is the 

other terror, the �re’s �ames.

Light&Medium Italic 9 pt

Light 20 pt

Extralight 20 pt

Book 20 pt

Regular 20 pt

Medium 20 pt

Bold 20 pt

Extrabold 20 pt



1 THE MAN WITHOUT QUALITIES (1930) - “A baro-
metric low hung over the Atlantic. It moved eastward 
toward a high-pressure area over Russia without as yet 
showing any [...]„ Robert Musil

Extralight pt 10 Medium pt 10

Bold pt 10

Extrabold pt 10

Regular pt 10

Light pt 10

Book pt 10

2 GRAVITY'S RAINBOW (1973) - “It has happened 
before,but there is nothing to compare it to now.It is too 
late. The Evacuation still proceeds, but it's all theatre.„ 
Thomas Pynchon

3 ULYSSES (1922) - “Stately, plump buck mulligan came 
from the stairhead, bearing a bowl of lather on which a 
mirror and a razor lay crossed. A yellow dressing gown, 
ungirdled„ James Joyce

5 IF ON A WINTER'S NIGHT A TRAVELER (1979) - 
“You are about to begin reading Italo Calvino's new 
novel, If on a winter's night a traveler.„ I
talo Calvino

6 THE CATCHER IN THE RYE (1951) - “If you really 
want to hear about it, the �rst thing you'll proba-
bly want to know is where I was born [...] 
J.D.Salinger

7 THE MAKING OF AMERICANS (1925) - “Once an 
angry man dragged his father along the ground 
through his own orchard.„ 
Gertrude Stein
 

4 MATTATOIO N.5 (1969) - “È tutto accaduto, più o 
meno. Le parti sulla guerra, in ogni caso, sono abbas-
tanza vere. Un tale che conoscevo fu veramente ucciso, 
[...]„ Kurt Vonnegut



CHARACTER SET

ABCDEFGHIJKLMNOPQRSTUVWXYZ - ÆŒÞÐ
ÁĂÂÄÀĀĄÅÃǼĆČÇĈĊĎĐÉĔĚÊËĖÈĒĘĞĜĢĠĦĤĲÍĬÎÏİÌĪĮĨĴĶĹĽĻĿŃŇŅŊÑÓŎÔÖÒ

ŐŌØÕŔŘŖŚŠŞŜȘŦŤŢȚÚŬÛÜÙŰŪŲŮŨẂŴẄẀÝŶŸỲŹŽŽ - 
alternates W  

abcdefghijklmnopqrstuvwxyz - æœþðß
ááâàāąåãćçĉċďđéĕěêëėēęğĝġħĥíĭîïìĳīįĩķĸĺļŀńňņŋñ

óŏôöòőōøõŕřŗśšşŝșŧťţțúŭûüùűūųůŵẅẁýŷÿỳźžż  alternates acrs 

0123456789
0123456789 0123456789 0123456789 

⁰¹²³⁴⁵⁶⁷⁸⁹01234567890123456789₀₁₂₃₄₅₆₇₈₉

UPPERCASE & ACCENTED

lowercase & accented

Figures & Mathematical notations 

Standard & Discretionary ligatures

. , : ;…!¡?¿·•*�# ․/\(){}[]-–—_„“” ‘ ’«»‹›”’¢¤$€ƒ£¥¢++−×÷=≠><≥≤±≈~¬^∞∫Ω∆∏∑µ∂%‰
↑↗→↘↓↙←↖◊@&¶§©®™°|¦†01234567890123456789

Punctuation & Symbols

� � � � � ffj � � � � fj � � � �



OTHER SCRIPT

АБВГҐДЕЗЖИЛМНОПРСТУФХЧЦШЩЬЪЫЉЊЅІЈЋЮЯЂЛ - ЃЁЙЇ
абвгґдежзклмнопрстуфхчцшщџьъыљњѕэіјћюя - ѓёйїђ 

CYRILLIC UPPERCASE & lowercase

abcdefghijklmnopqrstuvwxyz
áăâäàāąåãǽćčçĉċďđéĕěêëėẹèēęẽğǧĝģġħĥíĭîïịìĳīįĩĵķĸ

ĺľļŀłńňņñóŏôöọòőōǫøǿõŕřŗśšşŝșŧťțúŭûüụùűūųůũẃŵẅẁýŷÿỳȳỹźžż

CYRILLIC SMALLCAPS
абвгґдежзклмнопрстуфхчцшщџьъыљњѕэіјћюя

 

SMALLCAPS



TEXTPROOF

Antifašistická Akcia!!
The truth will set you free. But not until it is �nished with you.

Cantina Castelões™
The richest man is not he who has the most, but he who

Değiştirilemez Teklif
The sun machine is coming down, and we're gonna have a

Linee sospese per neve
Always forgive your enemies; nothing annoys them so much

Ert Þú Bókstafstrúar
All that we see or seem is but a dream within a dream.

Condizioni, pagamenti
The cure for boredom is curiosity. There is no cure

David Foster Wallace
Ground Control to Major Tom. Can you hear me, Major

Irwin Allen Ginsberg
You miss 100% of the shots you never take. Do you?

“LÄBIVIIMISESSE”
the man who only has a hammer, everything he encounters

RAPPREŻENTANZA
Over thinking, over analyzing, separates the body from the...

PAȘALÂCUL BUDA!!
Wear the grudge like a crown of negativity calculate what

DI ENERGIA E FORZA
We are what we repeatedly do; excellence, then, is not a choiche

FRANĠISKU JĊEMPEL
We can be heroes, forever and ever. What d'you say? [...]

AZGARAD FETIŠISM
I worry about being a success in a mediocre world⁽²⁾

150 COPII FRUMOȘI
We are choosing to be here right now hold on, stay inside

¿ES INESCRUTABLE?
I’d rather live with a good question than a bad answer.
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ABOUT

Tarif is a typeface family inspired by the multicultural utopia of Convivencia - the peaceful coexistence of 
Muslims, Christians and Jews in tenth century Andalusia that  played an important role in bringing to 
Europe the classics of Greek philosophy, togheter with Muslim culture and aesthetics.

Designed for Zetafonts by Andrea Tartarelli, is a slab serif typeface with a humanist skeleton and 
inverted contrast, subtly mixing latin zest, calligraphic details, extreme inktraps, and postmodern 
unorthodox reinvention of traditional grotesque letter shapes. 
The exuberant design, perfect for titling, logo and display use, is complemented by a wide range of seven 
weights allowing for solid editorial use and great readability in body text. Matching italics have been 
designed with the help of Maria Chiara Fantini and Cosimo Lorenzo Pancini, while Rania Azmi has 
collaborated on the design of the arabic version of Tarif, where the humanist shapes and inverted 
contrast of the latin letters �nd a natural connection with modern arabic letterforms.

As buoyant as reliable, Tarif includes also a wide array of Open Type Features (alternates, ligatures, 
positional numerals, case sensitive punctuation) to make design smooth and multi-script projects as 
exciting as a surf ride in the sunny Tarifa.



HOW TO USE FEATURES

All Zetafonts typefaces feature extra glyphs 
and functions that are available with Open 
Type technology (works on Adobe software, 
Word, and newer Os). Open Type features are 

activated in Illustrator, InDesign and Photo-
shop through multiple option checks in the 
Type → Open Type panel.

The OpenType format makes it possible to 
incorporate typographic features, such as 
small caps, ligatures, old style numerals 
and lining numerals, all within one font 
�le, thereby simplifying font 
management and usage.

To activate Open Type panel select
in the menu:
Window → Type → Opentype panel

for more information check our faq page:

http://bit.ly/zetafaq
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Light
Regular
Medium
Semibold
Bold

Black

Extralight Italic
Light Italic
Italic
Medium Italic
Semibold Italic
Bold Italic

Black Italic
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Light
Book
Regular
Medium
Bold

Black

Extralight Italic
Light Italic
Book Italic
Italic
Medium Italic
Bold Italic

Black Italic
Extrabold Extrabold Italic Extrabold Extrabold Italic
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NUMBERS

Afrikaans, Albanian, Asu, Azerbaijani, Basque, Bemba, Bena, Bosnian, Breton, Bulgarian, Catalan, 
Chiga, Colognian, Cornish, Croatian, Czech, Danish, Dutch, English, Esperanto, Estonian, Faroese, 
Filipino, Finnish, French, Friulian, Galician, Ganda, German, Greek, Gusii, Hungarian, Icelandic, Inari 
Sami, Indonesian, Irish, Italian, Jola-Fonyi, Kabuverdianu, Kalenjin, Kinyarwanda, Low German, Lower 
Sorbian, Luo, Luxembourgish, Luyia, Macedonian, Machame, Makhuwa-Meetto, Makonde, Malagasy, 
Malay, Maltese, Manx, Morisyen, North Ndebele, Northern Sami, Norwegian Bokmål, Norwegian 
Nynorsk, Nyankole, Oromo, Portuguese, Quechua, Romansh, Rombo, Rundi, Russian, Rwa, Samburu, 
Sango, Sangu, Scottish Gaelic, Sena, Serbian, Shambala, Shona, Slovak, Slovenian, Soga, Somali, Span-
ish, Swahili, Swedish, Swiss German, Taita, Teso, Turkish, Turkmen, Ukrainian, Upper Sorbian, Vunjo, 
Walser, Welsh, Western Frisian, Wolof, Zulu

1200+ chars
220+ languages

3 scripts: latin, arabic, cyrillic
COMMON LANGUAGES



STYLISTIC ALTERNATES

Stylistic Alternates or Stylistic Sets were designed to o�er a secondary form of a character.

↓ ↓ ↓
Discidia
Discidia



STYLISTIC SET 01, 02, 03...

There are more than one Stylistic Set. Check out the possibilities of text appearance.

Wayment

Wayment
↓ ↓



STANDARD                LIGATURES

� � � � � 

ffi→�
�

LIGATURE LIST

The standard ligatures are designed to correct awkward text combinations 
of letters, such as �, �, �. Such ligatures are applied by default



DISCRETIONARY               LIGATURES         �

� � � � � � �  

Discretionary Ligatures are ligatures applied at the user's discretion.

fb→�
LIGATURE LIST



SMALLCAPS

Tropicalia
Tropicalia

→

Small Caps feature substitutes lowercase with a capital versions of the letters sets within the x-height 



Лорем ипсум долор, дуо ут импетус диспутандо,фура салфеточка филонить  

CYRILLIC SCRIPT



ALTERNATE FIGURES

Tabular Figures are especially useful while setting columns of numbers, such as in �nancial reports. 

123
proportional old style

123
proportional lining

|1|2|3|
tabular lining

|1|2|3|
tabular old style

↓
↓



POSITIONING FIGURES/FRACTIONS

12⁄23
fraction

1ˢ
ordinals superscript

superior

X¹²
subscript-inferior

H₂O

numerator

N123
denominator

D234
These various kind of �gures are used for fractions, footnote references, chemical compounds, and as mathematical 

exponents.



SPECIAL LIGATURES

(1)(2) 
circular number

12 

black circular number

((1))((2))
↓ ↓

12 

<+-/|+> 
arrows

↓
 ←↘↓↙→

 ↖↑↗

The Special Ligatures o�er you the possibility to get special symbols by using key combinations without 
glyph panel. These are activated enabling Discretionary Ligatures.



[No.]
number

№

copyright

(C)

© ®

registered

(R) [TM]
trademark

™
↓ ↓ ↓ ↓

LETTER COMBINATIONS

There are also Special letter combinations  this solution o�er you the possibility to get special symbols by using 
key combinations without glyph panel. These are activated enabling Discretionary Ligatures.



The so-called ‘psychotically depressed’ person who tries to 

kill herself doesn’t do so out of quote ‘hopelessness’ or any 

abstract conviction that life’s assets and debits do not 

square. And surely not because death seems suddenly 

appealing. The person in whom Its invisible agony 

reaches a certain unendurable level will kill herself 

the same way a trapped person will eventually 

TEXT PROOF

The so-called ‘psychotically 
depressed’ person who tries to kill 
herself doesn’t do so out of quote 

‘hopelessness’ or any abstract 
conviction that life’s assets and 

debits do not square. And surely 
not because death seems 

suddenly appealing. The person 
in whom Its invisible agony 

reaches a certain unendurable 
level will kill herself the same 

way a trapped person will 
eventually jump from the 

window of a burning high-rise. 
Make no mistake about people 

who leap from burning windows. 
Their terror of falling from a 

great height is still just as great 
as it would be for you or me 

standing speculatively at the 
same window just checking out 
the view; i.e. the fear of falling 

remains a constant. The variable 
here is the other terror, the �re’s 

�ames.

Light&Medium Italic 9 pt

Light 20 pt

Extralight 20 pt

Book 20 pt

Regular 20 pt

Medium 20 pt

Bold 20 pt

Extrabold 20 pt



1 THE MAN WITHOUT QUALITIES (1930) - “A 
barometric low hung over the Atlantic. It moved 
eastward toward a high-pressure area over Russia without 
as yet showing any [...]„ Robert Musil

Extralight pt 10 Medium pt 10

Bold pt 10

Extrabold pt 10

Regular pt 10

Light pt 10

Book pt 10

2 GRAVITY'S RAINBOW (1973) - “It has happened 
before,but there is nothing to compare it to now.It is too 
late. The Evacuation still proceeds, but it's all theatre.„ 
Thomas Pynchon

3 ULYSSES (1922) - “Stately, plump buck mulligan came 
from the stairhead, bearing a bowl of lather on which a 
mirror and a razor lay crossed. A yellow dressing gown, 
ungirdled„ James Joyce

5 IF ON A WINTER'S NIGHT A TRAVELER (1979) - 
“You are about to begin reading Italo Calvino's new 
novel, If on a winter's night a traveler.„ I
talo Calvino

6 THE CATCHER IN THE RYE (1951) - “If you really 
want to hear about it, the �rst thing you'll proba-
bly want to know is where I was born [...] 
J.D.Salinger

7 THE MAKING OF AMERICANS (1925) - “Once an 
angry man dragged his father along the ground 
through his own orchard.„ 
Gertrude Stein
 

4 MATTATOIO N.5 (1969) - “È tutto accaduto, più o 
meno. Le parti sulla guerra, in ogni caso, sono abbas-
tanza vere. Un tale che conoscevo fu veramente ucciso, 
[...]„ Kurt Vonnegut



CHARACTER SET

ABCDEFGHIJKLMNOPQRSTUVWXYZ - ÆŒÞÐ
ÁĂÂÄÀĀĄÅÃǼĆČÇĈĊĎĐÉĔĚÊËĖÈĒĘĞĜĢĠĦĤĲÍĬÎÏİÌĪĮĨĴĶĹĽĻĿŃŇŅŊÑÓŎÔÖÒ

ŐŌØÕŔŘŖŚŠŞŜȘŦŤŢȚÚŬÛÜÙŰŪŲŮŨẂŴẄẀÝŶŸỲŹŽŽ - 
alternates W  

abcdefghijklmnopqrstuvwxyz - æœþðß
ááâàāąåãćçĉċďđéĕěêëėēęğĝġħĥíĭîïìĳīįĩķĸĺļŀńňņŋñ

óŏôöòőōøõŕřŗśšşŝșŧťţțúŭûüùűūųůŵẅẁýŷÿỳźžż  alternates acrs 

0123456789
0123456789 0123456789 0123456789 

⁰¹²³⁴⁵⁶⁷⁸⁹01234567890123456789₀₁₂₃₄₅₆₇₈₉

UPPERCASE & ACCENTED

lowercase & accented

Figures & Mathematical notations 

Standard & Discretionary ligatures

. , : ;…!¡?¿·•*�# ․/\(){}[]-–—_„“” ‘ ’«»‹›”’¢¤$€ƒ£¥¢++−×÷=≠><≥≤±≈~¬^∞∫Ω∆∏∑µ∂%‰
↑↗→↘↓↙←↖◊@&¶§©®™°|¦†01234567890123456789

Punctuation & Symbols

� � � � � ffj � � � � fj � � � �



OTHER SCRIPT

АБВГҐДЕЗЖИЛМНОПРСТУФХЧЦШЩЬЪЫЉЊЅІЈЋЮЯЂЛ - ЃЁЙЇ
абвгґдежзклмнопрстуфхчцшщџьъыљњѕэіјћюя - ѓёйїђ 

CYRILLIC UPPERCASE & lowercase

abcdefghijklmnopqrstuvwxyz
áăâäàāąåãǽćčçĉċďđéĕěêëėẹèēęẽğǧĝģġħĥíĭîïịìĳīįĩĵķĸ

ĺľļŀłńňņñóŏôöọòőōǫøǿõŕřŗśšşŝșŧťțúŭûüụùűūųůũẃŵẅẁýŷÿỳȳỹźžż

CYRILLIC SMALLCAPS
абвгґдежзклмнопрстуфхчцшщџьъыљњѕэіјћюя

 

SMALLCAPS



TEXTPROOF

Antifašistická Akcia!!
The truth will set you free. But not until it is �nished with you.

Cantina Castelões™
The richest man is not he who has the most, but he who

Değiştirilemez Teklif
The sun machine is coming down, and we're gonna have a

Linee sospese per neve
Always forgive your enemies; nothing annoys them so much

Ert Þú Bókstafstrúar
All that we see or seem is but a dream within a dream.

Condizioni, pagamenti
The cure for boredom is curiosity. There is no cure

David Foster Wallace
Ground Control to Major Tom. Can you hear me, Major

Irwin Allen Ginsberg
You miss 100% of the shots you never take. Do you?

“LÄBIVIIMISESSE”
the man who only has a hammer, everything he encounters

RAPPREŻENTANZA
Over thinking, over analyzing, separates the body from the...

PAȘALÂCUL BUDA!!
Wear the grudge like a crown of negativity calculate what

DI ENERGIA E FORZA
We are what we repeatedly do; excellence, then, is not a choiche

FRANĠISKU JĊEMPEL
We can be heroes, forever and ever. What d'you say? [...]

AZGARAD FETIŠISM
I worry about being a success in a mediocre world⁽²⁾

150 COPII FRUMOȘI
We are choosing to be here right now hold on, stay inside

¿ES INESCRUTABLE?
I’d rather live with a good question than a bad answer.


